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IP 115 Single Line Speakerphone

Synopsis
The ShoreTel IP115 Telephone is a cost-effective alternative that provides one call appearance and basic phone features, 
including full speakerphone functionality.

Background
The IP 110 was introduced in 2006 as an entry level IP phone. The IP 115 is based on the IP 110 phone, with the primary 
difference of the addition of an external microphone to the IP 115 to support full speakerphone functionality.

Description
For detailed information on using the IP 115 Telephone, refer to the ShoreTel IP 115 Telephone User Interface Guide. The 
ShoreWare 7.5 Client Release Notes lists the operational differences between the IP 115 and IP110.

Figure 1 displays the IP 115 body.

Configuration
Configuration tasks for the IP 115 are identical to those for the IP 110.

Figure 1 IP 115 Telephone
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IP 265 Telephone

Synopsis
The ShoreTel IP265 telephone is a mid-range phone that, in addition to most basic functions, features an LCD Color display.

Background
The ShoreTel IP265 feature set is based on the IP230. ShoreTel IP265 enhancements include:

• Six tri-color (red, orange, green) programmable buttons. (Note that the IP230 provides three single-color 
programmable buttons.)

• A 2.7 inch color TFT LCD display with backlighting.

Description
The ShoreTel IP265 phone, shown in Figure 2, provides the following features:

• Six programmable buttons with integrated tri-color LEDs. 
Buttons can be configured for various functions in addition to call handling, such as extension monitoring and
speed dialing. The top button is reserved for activating a call appearance.

• 2.7 inch color TFT LCD color display, 320 x 240 pixels
The LCD is capable of displaying a 24-bit RGB bitmap file and offers a backlit display.

• Eight dedicated feature buttons (Voice Mail, Transfer, Options, Conference, Directory, Intercom, Redial, and Hold)

• Ethernet switch port for connecting a PC to the phone’s network.

For detailed information on available options, including usage instructions, refer to the ShoreTel 265 IP Phone User Interface 
Guide.

For installation instructions, refer to the ShoreTel 265 IP Phone Quick Install Guide.

For information on assigning network parameters to the phone, refer to the ShoreTel Planning and Installation Guide.

Figure 2 ShoreTel IP265 Phone
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Configuring the LCD Display
The wallpaper displayed by the LCD display is configured by downloading a bitmap file from the ShoreWare server to the 
phone. The following sections describes image file requirements and the method for downloading wallpaper files to the IP 265.

Wallpaper File Specifications
The wallpaper is 320 by 240 pixels and uses an uncompressed 256-color .bmp file format. Each of the 256 colors is defined by 
a 24-bit RGB value. Bitmap files can be composed by using MS Paint or any other editor that can create Paint compatible files.

To verify that a graphic file can be used by the IP 265 as a wallpaper image:

1. Open the image in MS Paint.

2. Open the Attributes panel by selecting Image -> Attributes from the main menu.

3. Verify the following parameters are set as follows and make the appropriate adjustments:

• Width = 320

• Height = 240

• Units = Pixels

• Colors = Colors

4. Close the Attributes panel by clicking OK.

5. Open the Save As panel by selecting File -> Save As from the main menu.

6. Verify that Save as type is set to 24-bit Bitmap (*.bmp;*.dib).

7. Note the proposed file name and directory, and save the file by clicking Save.

Downloading the File to all System IP 265 Phones
The following procedure loads wallpaper files to all IP 265 phones.

1. Save the wallpaper file on the HQ Server computer in following directory: C:/Inetpub/ftproot

2. Access the C:/Inetpub/ftproot directory on the HQ Server.

3. Open s36custom.txt 

4. Add the following line to the open file: Wallpaper2pixmap abc.bmp, entering the name of the wallpaper file in
place of abc.bmp, then save and close the file.

For example, if the wallpaper file is name logo.bmp, then enter Wallpaper2pixmap logo.bmp.

5. Open shore_s36.txt

6. Verify that the file contains the following line: Include s36custom.txt. Add this line to the file if it is not present.

7. Reset the phones.

Verify that, when each phone reboots, they include the line shore_xxxxxx.txt, where xxxxxx is the MAC address
of the phone, and that the phone saves the wallpaper file.

8. Verify that each phone displays the wallpaper file after they are reset.

Downloading the File to a Single IP 265 Phone
The following procedure loads wallpaper files to one IP 265 phone.

1. Save the wallpaper file on the HQ Server computer in following directory: C:/Inetpub/ftproot

2. Access the C:/Inetpub/ftproot directory on the HQ Server.
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3. Create a text file named shore_xxxxxx.txt, where xxxxxx is the MAC address of the phone.

4. Add the following line to the open file: Wallpaper2pixmap abc.bmp, entering the name of the wallpaper file in
place of abc.bmp, then save and close the file.

For example, if the wallpaper file is name logo.bmp, then enter Wallpaper2pixmap logo.bmp.

5. Open shore_s36.txt 

6. Add the following line to the open file: Include shore_xxxxxx.txt, where xxxxxx is the MAC address of the
phone.

7. Reset the phone.

Verify, while the phone reboots, that it includes shore_xxxxxx.txt and saves the wallpaper file.

8. Verify that the phone displays the wallpaper file after it is reset.
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IP 565g Color Telephone

Synopsis
The IP 565g telephone is ShoreTel’s high-end phone. In addition to supporting all functions included in other ShoreTel phones, 
the IP 565g features an LCD color display and Bluetooth capability.

Background
The ShoreTel IP 565g feature set is based on the IP560g. ShoreTel IP 565g enhancements include:

• Bluetooth wireless capability1

• A 3.5 inch color TFT LCD display with backlighting

Description
The ShoreTel IP 565g phone, shown in Figure 3, provides the following features:

• Six programmable buttons with integrated tri-color LED. 
Buttons can be configured various functions in addition to call handling, such as extension monitoring or speed
dialing. The top button is reserved for activating a call appearance.

• 3.5 inch color TFT LCD color display, 320 x 240 pixels. 
The LCD can display a 24-bit RGB bitmap file.

• Bluetooth wireless capability
In addition to pairing operations that associate the phone to a wireless headset, the Bluetooth functions supported
by the IP 565g include call answering, call transfers to the headset or phone, end call, make call, call reject, and
redial last number.

• Eight dedicated feature buttons (Voice Mail, Transfer, Options, Conference, Directory, Intercom, Redial, and Hold)

• Ethernet switch port for connecting a PC to the phone’s network

Installation Details
The ShoreTel IP 565g telephone requires a gigabit-compatible Power over Ethernet (POE) power supply that complies with 
IEEE802.af. The IP 565g phone is a Class 3 device with a maximum power consumption of 8.2 watts. When planning capacity 
requirements with Gig POE switches on multiple deployments, allot 8.2 watts for each IP 565g.

1. For more information on configuring and using Bluetooth, refer to the ShoreTel 565g IP Phone User Guide.

Figure 3 ShoreTel IP 565g Phone
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The IP 565g phone only supports Gigabit Ethernet speeds when used with a Gigabit Ethernet-compatible Power over Ethernet 
(PoE) supply. When used with the standard ShoreTel PoE adaptor, the device will continue to work but only at 10MB or 100MB.

The IP 565g model cannot be daisy-chained from the Button Box because it requires more power than the Button Box can 
supply. This device configuration may result in one or more devices shutting down or rebooting.

The ShoreTel IP 565g telephone requires Category 5e or Category 6 Ethernet cables. Category 5 Ethernet cables are not 
supported and may lead to lower connection speed and performance issues during high-data transfer operations.

Configuration and Usage Instructions
For detailed information on available options, including usage instructions, refer to the ShoreTel 565g IP Phone User Interface 
Guide.

For installation instructions, refer to the ShoreTel 565g IP Phone Quick Install Guide.

For information on assigning network parameters to the phone, refer to the ShoreTel Planning and Installation Guide.

Configuring the LCD Display
The wallpaper displayed by the LCD display is configured by downloading a bitmap file from the ShoreWare server to the 
phone. The following sections describes image file requirements and the method for downloading wallpaper files to the IP 565g.

Wallpaper File Specifications
The wallpaper is 320 by 240 pixels and uses an uncompressed 256-color .bmp file format. Each of the 256 colors is defined by 
a 24-bit RGB value. Bitmap files can be composed by using MS Paint or any other editor that can create Paint compatible files.

To verify that a graphic file can be used by the IP 565g as a wallpaper image:

1. Open the image in MS Paint.

2. Open the Attributes panel by selecting Image -> Attributes from the main menu.

3. Verify the following parameters are set as follows and make the appropriate adjustments:

• Width = 320

• Height = 240

• Units = Pixels

• Colors = Colors

4. Close the Attributes panel by clicking OK.

5. Open the Save As panel by selecting File -> Save As from the main menu.

6. Verify that Save as type is set to 24-bit Bitmap (*.bmp;*.dib).

7. Note the proposed file name and directory, and save the file by clicking Save.

Downloading the File to all System IP 565g Phones
The following procedure loads wallpaper files to all IP 565g phones.

1. Save the wallpaper file on the HQ Server computer in following directory: C:/Inetpub/ftproot

2. Access the C:/Inetpub/ftproot directory on the HQ Server.

3. Open s6ccustom.txt 

4. Add the following line to the open file: Wallpaper2pixmap abc.bmp, entering the name of the wallpaper file in
place of abc.bmp, then save and close the file.



ShoreWare Server Software Release Notes IP 565g Color Telephone

24 July 2008 Page 7 of 59

For example, if the wallpaper file is name logo.bmp, then enter Wallpaper2pixmap logo.bmp.

5. Open shore_s6c.txt

6. Verify that the file contains the following line: Include s6ccustom.txt. Add this line to the file if it is not present.

7. Reset the phones.

Verify that, when each phone reboots, they include the line shore_xxxxxx.txt, where xxxxxx is the MAC address
of the phone, and that the phone saves the wallpaper file.

8. Verify that each phone displays the wallpaper file after they are reset.

Downloading the File to a Single IP 565g Phone
The following procedure loads wallpaper files to one IP 565g phone.

1. Save the wallpaper file on the HQ Server computer in following directory: C:/Inetpub/ftproot

2. Access the C:/Inetpub/ftproot directory on the HQ Server.

3. Create a text file named shore_xxxxxx.txt, where xxxxxx is the MAC address of the phone.

4. Add the following line to the open file: Wallpaper2pixmap abc.bmp, entering the name of the wallpaper file in
place of abc.bmp, then save and close the file.

For example, if the wallpaper file is name logo.bmp, then enter Wallpaper2pixmap logo.bmp.

5. Open shore_s6c.txt 

6. Add the following line to the open file: Include shore_xxxxxx.txt, where xxxxxx is the MAC address of the
phone.

7. Reset the phone.

Verify, while the phone reboots, that it includes shore_xxxxxx.txt and saves the wallpaper file.

8. Verify that the phone displays the wallpaper file after it is reset.
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ShoreGear 90BRI Switch

Synopsis
The ShoreGear 90BRI switch supports 30 IP phones, 4 BRI ports, and four analog extensions simultaneously.

Background
The ShoreGear 90BRI is one component of a hardware line that is provided to improve density, and add basic rate functionality.

Description
The ShoreGear 90BRI is 1U, half-rack width device that supports 30 IP phones, 4 BRI ports, and 4 analog extension ports. The 
ShoreTel Dual Tray is required for mounting the switch in a 19 inch rack. Rubber feet are provided for stacking switches without 
a rack. Cooling vents are located on the sides and back; air circulates through the sides and out the back. The unit is set to factory 
defaults by pressing a pinhole button on the front panel.

LED Indicators
The ShoreGear 90BRI displays the following LEDs: 

• Power Indicator

The blue Power LED indicates the unit’s operational status

No blinking – unit operating normally
2 blinks – unit failed self-test
3 blinks – unit is ftp booting
4 blinks – unit has no IP address
5 blinks – not used
6 blinks – no response from DHCP server: unit is using cached IP address last obtained via DHCP

• Status Indicator

The Status LED reports the cumulative status of all ports, as specified by the following patterns. When more than
one condition exists, the LED displays the valid pattern that appears first in the following list:

Yellow slow blink (1 sec. on/off) – TMS connection down
Yellow fast blink (100 msec on/off) – At least one active call and at least one port is out-of-service.
Steady yellow – At least one port is out-of-service.
Green fast blink (100 msec on/off) – at least one port is active.
Steady Green – all ports idle.

• Ethernet

The Ethernet LEDs indicates the status of the Ethernet connection:

Link/Act – Green

Off – no link
Steady On – link up
Flashing – presence of ethernet traffic

10/100 Mb – Green

Off – 10 Mb/s link
On – 100 Mb/s link
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• BRI

L1: off L2: off port not configured in ShoreWare Director
L1: yellow L2: off port inactive or not configured
L1: green L2: off Layer 1 active, Layer 2 not active
L1: green L2: green Layer 1 active, Layer 2 active
L1: green L2: flashing green Layer 1 active, Layer 2 active, Call in progress (Layer 3 active)

ShoreWare Director Panels

Edit ShoreGear 90BRI Edit Panel
To access edit panels for installed SG-90 BRI switches, select Administration -> Switches from the Director menu, then select 
the name of the desired switch from the Switches table. Figure 4 displays the Director ShoreGear 90BRI Edit panel.

The SG-90BRI has four BRI spans, each with 2 channels and independent signaling parameters. Each span can be enabled or 
disabled individually. Signaling parameters for each span persists in the database even when the span is disabled. When a span 
is enabled, both ports in that span can be used only for trunks and cannot be reserved for IP phones or SIP trunks. When a span 
is disabled, either or both ports can be reserved for IP phones or SIP trunks.

Figure 4 ShoreGear 90BRI Edit panel
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BRI ports are labeled on Director as follows:

• Digital Ports (8): 1-1, 1-2, 2-1, 2-2, 3-1, 3-2, 4-1, 4-2

• Analog Ports (4): 9 through 12

• Paging and Nightbell: Not shown on Director

Each BRI span supports PMP configuration, including Point-to-Point (PP) and Point-to-Multipoint (PMP) protocols, for 
connecting to legacy switches.

The analog ports are shown above the BRI spans. An analog port drop-down menu is provided to allow individual port 
provisioning for use as either an analog extension, MakeMe conference port, or group of 5 SIP trunks.

Each BRI span displays their respective signaling parameters followed by the 2 ports belonging to the span.

ShoreGear 90BRI Switch Maintenance Panel
To access maintenance panels for installed SG-90BRI switches, select Maintenance -> Quick Look from the Director Menu, 
then select the site name where the desired BRI switch is located from the Switches table. Figure 5 displays the Director BRI 
Switch Maintenance panel.

The Maintenance panel displays the analog and BRI digital ports. The analog ports are listed first. For roll-up status on the 
Maintenance panel, the BRI ports have higher priority than the analog ports. You can reset an individual BRI span without 
restarting the entire switch from this panel.

Figure 5 Director BRI Switch Maintenance panel
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ShoreGear 220T1A Switch

Synopsis
The ShoreGear 220T1A switch supports 70 IP phones, four analog extension ports, two analog extension trunks, and a single 
T1 line that is capable of performing PRI or CAS signaling.

Background
The ShoreGear 220T1A switch is one component of a hardware line that is provided to improve IP density and support analog 
extensions.

Description
The ShoreGear 220T1A is 1U, half-rack width device that supports 70 IP phones, four analog extension ports, two analog 
extension trunks, and one T1 line (PRI or CAS signaling). The ShoreTel Dual Tray is required for mounting the switch in a 19 
inch rack. Rubber feet are provided for stacking switches without a rack. Cooling vents are located on the sides and back; air 
circulates through the sides and out the back. The unit is reset to factory defaults by pressing a pinhole button on the front panel.

LED Indicators
The ShoreGear 220T1A displays the following LEDs: 

• Power Indicator

The blue Power LED indicates the unit’s operational status:

No blinking – unit operating normally
2 blinks – unit failed self-test
3 blinks – unit is ftp booting
4 blinks – unit has no IP address
5 blinks – not used
6 blinks – no response from DHCP server: unit is using cached IP address last obtained via DHCP

• Status Indicator

The Status LED reports the cumulative status of all ports, as specified by the following patterns. When more than
one condition exists, the LED displays the valid pattern that appears first in the following list:

Yellow slow blink (1 sec. on/off) – TMS connection down
Yellow fast blink (100 msec on/off) – At least one active call and at least one port is out-of-service.
Steady yellow – At least one port is out-of-service.
Green fast blink (100 msec on/off) – at least one port is active.
Steady Green – all ports idle.

• Ethernet

The Ethernet LEDs indicates the status of the Ethernet connection:

Link/Act – Green

Off – no link
Steady On – link up
Flashing – presence of ethernet traffic

10/100 Mb – Green

Off – 10 Mb/s link
On – 100 Mb/s link
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• T1/E1

The T1/E1 LEDs display the status of the PCM links.

Line coding

Green – line coding signal is good
Yellow – bipolar violations
Steady red – loss of signal
Flashing red – loopback active (local or CO)

Framing

Green – T1/E1 is in frame
Yellow – yellow alarm from CO
Flashing yellow – frame bit error rate exceeded limits
Slow flashing yellow – frame bit error rate 10e-6
Fast flashing yellow – frame bit error rate 10e-3
Red – T1/E1 is out of frame (OOF)
Flashing red – loopback active (local or CO)

ShoreWare Director Panels

ShoreGear 220T1A Edit Panel
To access edit panels for installed SG-220T1A switches, select Administration -> Switches from the Director menu, then select 
the name of the desired switch from the Switches table. Figure 6 displays the Director Edit ShoreGear 220T1A Edit panel.

Digital ports can be reserved for IP phones or SIP trunks on an individual port basis. T1 and analog ports are labeled on Director 
as follows:

• Digital Ports (24): 1 through 24

• Analog Ports (6): 1, 2, 9, 10, 11, 12

• Paging and Nightbell: Not shown on Director

The analog ports are displayed above the digital ports. A trunk group drop-down is added to the analog ports list to facilitate 
individual trunk provisioning without visiting the individual trunk page. The digital port signaling options (PRI, QSIG, 
Master/Slave) appears above the list of digital ports and below the analog port list.

ShoreGear 220T1A Switch Maintenance Panel
To access maintenance panels for installed SG-220T1A switches, select Maintenance -> Quick Look from the Director Menu, 
then select the site name where the desired switch is located from the Switches table. Figure 7 displays the Director 220T1A 
Switch Maintenance panel.

The Maintenance panel displays the analog and digital ports. The analog ports are listed first. For roll-up status on the 
Maintenance panel, the digital ports have higher priority than the analog ports.
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Figure 6 Director Edit ShoreGear 220T1A Edit panel
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Figure 7 Director 220T1A Switch Maintenance panel
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Multiple Emergency Number Support

Synopsis
ShoreWare 7.5 expands the number of emergency numbers available at each site to ten.

Background
ShoreWare defines emergency numbers for each site that are used to contact emergency service providers. Emergency numbers 
differ from other numbers in that they are dialable, regardless of the caller’s external call authorization level, and nonroutable 
(dialed out on a local trunk without being converted into canonical format).

Previous ShoreWare versions defined one emergency number for each site. This feature enhancement permits each site a 
maximum of ten emergency numbers to accommodate locations where multiple emergency service numbers are required. 
ShoreWare emergency number handling methods not affected by this enhancement are not modified.

Description
This feature supports a maximum of ten emergency numbers per site.

Note: ShoreTel supports the official emergency number(s) of the respective country. When entering non-official emergency 
numbers, you must adhere to the dialing plan of the country where the site is located.

This feature extends emergency number availability for each site without losing existing emergency number functionality:

• End users retain the ability to dial emergency number without an access code, but make that feature selectable by 
number.

• ShoreWare generates a Windows Application event for each emergency number call.

The feature enhancement modifies the event to indicate the emergency number that was called.

• Allow extensions underneath emergency numbers (e.g. x112 in Germany).

Configuration
The Emergency Number List is located at the bottom of the Edit Site panel, as shown in Figure 8. The Edit Site panel is 
accessed by selecting Administration -> Sites from the Director menu. 

The list in Figure 8 is configured for two emergency numbers. Each emergency number entry requires completion of the 
following parameters:

• Trunk Access Code Required checkbox: When this option is selected, a caller must dial the Trunk Access Code 
before dialing the specified emergency number. If Trunk Access Code Required is not selected, entering the Trunk 
Access Code before the Emergency number is permitted, but not required, to complete the call.

• Data Entry Field: Enter the exact emergency number required to contact the associated Emergency Service 
Provider. If Trunk Access Code Required is selected, you can also enter a number in canonical format

To add additional emergency numbers to a site’s configuration, click the Add More... button located to the right of the data 
entry field of the last emergency number on the list.

When a new site is added to a configuration, the Add Site panel lists a data entry field for one emergency number. This field is 
initially filled with the default listed in the country table.
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Examples

Example 1: Typical U.S. Implementation
In most U.S. locations, entering 911 in the Data Entry Field and not selecting Trunk Access Code Required allows callers at a 
site to contact Emergency services by dialing 911.

Example 2: Requiring a Trunk Access Code
Some municipalities may offer 800 numbers for specific emergency services, such as poison control. To specify an 800 number 
as an emergency number, enable Trunk Access Code Required, then enter the specific 800 number in the data entry field.

For this example, assume that the area poison control number is (800) 555-1111. To define this number as an Emergency 
number in addition to 911:

1. Click the Add More... button.

The panel displays emergency number parameters for a second number under Emergency Number List.

2. Select Trunk Access Code Required.

3. Enter +1 (800) 555-1111 in the data entry field.

If the trunk access code is 9, then an end user can reach the poison control number by dialing 9-1-800-555-1212.

Figure 9 displays the Emergency Number List configured by this example.

Figure 8 Edit Site Panel – Multiple Emergency Numbers
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Example 3: Programming Multiple Emergency Numbers
France specifies the following emergency numbers: 112-EU Harmonized number; 115-Social Services; 15-Ambulance; 
17-Police; and 18-Fire. To specify each of these as emergency numbers:

1. Enter 112 in the first data entry field of the Emergency Number List.

2. Click the Add More... button.

The panel displays a new Trunk Access Code Required option box and data entry field in the Emergency
Number List.

3. Enter 115 in the new data entry field.

4. Repeat Step 2 and Step 3 for the other three emergency numbers (15, 17, 18).

Figure 10 displays the Emergency Number List configured by this example.

Emergency Services Call Event Log
The Emergency Services Call Event (NT Event 1319) supports multiple emergency numbers by specifying the emergency 
number that was called, as follows:

Emergency Services Call to <emergency_#> on port <port_#> from user <caller_name> at <caller_extension>.

Figure 11 displays a Director Emergency Services Call Event panel.

Figure 9 Emergency Number Example – Requiring a Trunk Access Code

Figure 10 Emergency Number Example – Multiple Numbers



ShoreWare Server Software Release Notes Multiple Emergency Number Support

24 July 2008 Page 18

Figure 11 Emergency Services Call Event Log
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ShoreWare® Mobile Call Manager

Introduction
ShoreWare Mobile Call Manager expands the remote user feature set by adding Call Manager functionality to mobile devices. 
Specific Call Manager features include voicemail access, QuickDialer, configuring call handling, call history, and external 
assignment settings.

This chapter provides the following information:

• A description of the ShoreWare Mobile Call Manager

• Administration configuration tasks required to support ShoreWare Mobile Call Manager

• Instructions for installing and configuring ShoreWare Mobile Call Manager on a mobile device

• End user instructions for using ShoreWare Mobile Call Manager

Background
Previous releases supported mobile use of ShoreWare features through Office Anywhere. ShoreWare Mobile Call Manager 
expands the remote user feature set by adding Call Manager functionality to mobile devices. 

Feature Description

Functional
ShoreWare Mobile Call Manager comprises the following components:

• Mobile Call Manager Server (MCMS) is a ShoreWare server component that manages all communications with 
ShoreWare Mobile Call Manager clients. Installing the ShoreWare Server includes the automatic installation of 
MCMS.

• The Mobile Call Manager (MCM) client application is installed on each mobile device. The ShoreWare Mobile 
Call Manager accesses ShoreWare functions, configuration information, voicemail, and calling history by 
communicating with the MCMS.

The MCMS is located on the main and distributed ShoreWare servers. Secure wireless communication sessions with specified 
mobile devices are conducted through a Reverse Proxy Server or a Blackberry Enterprise Server.

Mobile devices receive MCM Client Installation Files from the ShoreWare Server through a Blackberry Enterprise Server. After 
installing these files, the end user can configure the mobile device to access the ShoreWare server through an IP address 
provided by the system administrator.

ShoreWare Mobile Call Manager enables a mobile device to function as a ShoreWare extension and provides an interface, 
similar to Call Manager, for accessing ShoreWare client information. In addition to initiating calls from the Call History, Voice 
Mail, and QuickDialer screens, end users can access their voice mail, configure call handling mode settings, set the active call 
handling mode, configure Office Anywhere settings, and activate Office Anywhere from the ShoreWare Mobile Call Manager 
user interface.
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Requirements

ShoreWare Mobile Call Manager Support – Languages
ShoreWare Mobile Call Manager is currently supported in English only.  There is no support for other languages, nor for 
extended character sets. The application can be used outside the United States in countries that do not predominantly speak 
English, but all ShoreWare Mobile Call Manager text will appear in English (regardless of the language of the BlackBerry 
operating system).

ShoreWare Mobile Call Manager Support – Carriers

ShoreWare Mobile Call Manager is supported across carriers that allow installation of third-party applications onto the 
BlackBerry device.

ShoreWare Mobile Call Manager Support – Devices

ShoreWare Mobile Call Manager is supported on the following devices:

• BlackBerry 8700

• Blackberry 7290

MCMS
The Mobile Call Manager Server (MCMS) is the ShoreWare server component that manages ShoreWare Mobile Call Manager 
client communications. The MCMS is installed on the ShoreWare HQ and DVM servers as part of the normal ShoreWare Server 
installation process. The MCMS contains no configuration parameters and requires no administrator intervention or monitoring 
during normal ShoreWare operations.

MCM Client Installation Files
MCM Client Installation Files are a set of files that provide the ShoreWare Mobile Call Manager client application to mobile 
devices. Clients download these files to their mobile devices from a server specified by the system administrator. MCM Client 
Installation Files are maintained and updated by the system administrator. 

These files are originally placed on the ShoreWare Server as part of the ShoreWare installation, then moved by the system 
administrator to a server that can be accessed by the mobile devices of system end users.

Servers
Mobile devices must connect with the ShoreWare server to access MCMS services. Enterprise security requirements affect the 
structure of the network that provides application support. The following section describes servers that are typically used to 
implement ShoreWare Mobile Call Manager.

Blackberry Enterprise Server (BES)
The Blackberry Enterprise Server is a middleware application, offered by Research in Motion, that supports ShoreWare Mobile 
Call Manager by synchronizing email and PIM information through a secure back channel between the MCMS and BlackBerry 
mobile devices. The BES also supports Client Installation File downloads from ShoreWare to BlackBerry devices.

Reverse Proxy Server
A Reverse Proxy Server is a proxy server that is normally installed in front of web servers. Internet communications addressed 
to a web server are routed through the Reverse Proxy Server, which can process the request or pass the request to the specified 
web server. Implementing a Reverse Proxy Server within the corporate DMZ maintains the integrity of the corporate firewall 
and insulates the ShoreWare Server, along with other corporate assets, from public networks.

A Reverse Proxy Server provides secure wireless communication between Mobile Devices running ShoreWare Mobile Call 
Manager and ShoreWare server. A Reverse Proxy Server can serve the same role as a BES for conducting ShoreWare Mobile 
Call Manager wireless communication sessions.



ShoreWare Server Software Release Notes ShoreWare® Mobile Call Manager

24 July 2008 Page 21

Direct communication between an MCMS with the mobile devices is not recommended. This configuration compromises the 
integrity of the corporate firewall and exposes the ShoreWare Server and other connected corporate assets to attacks from public 
networks.

Administrator Configuration
ShoreWare Mobile Call Manager administration comprises two application activities: client application installation file delivery 
to the mobile devices and ShoreWare Mobile Call Manager communication sessions with the mobile devices. Configuring 
ShoreWare to support ShoreWare Mobile Call Manager requires the completion of the following tasks:

• Installing at least one additional server

• Acquiring the required ShoreWare Mobile Call Manager license 

• Authorizing clients to use ShoreWare Mobile Call Manager

MCMS installation is performed with the installation of a ShoreWare server. The MCMS requires no additional installation or 
configuration. The following sections describe the tasks required to install and support ShoreWare Mobile Call Manager.

Server Installation (Headquarters and DVM)
Server configuration options:

• ShoreWare Mobile Call Manager communication sessions with a BlackBerry device are supported by a BES or a 
Reverse Proxy Server.

• Client Installation File downloads to a BlackBerry are supported through a BES.

Systems   can use a BES server for all ShoreWare Mobile Call Manager activities.

BES
The BlackBerry Enterprise Server supports ShoreWare Mobile Call Manager communications between the ShoreWare server 
and BlackBerry devices. BlackBerry devices can also access MCM Client Installation Files located on the ShoreWare server 
through the BES. The BES implements a secure connection, similar to that of a VPN, to provide access for mobile devices to 
resources that are protected by the corporate firewall.

For information on installing a BES, refer to BES installation instructions provided by Research in Motion.

Reverse Proxy Server
Reverse Proxy Servers are used for conducting ShoreWare Mobile Call Manager communication sessions between the 
ShoreWare server and all supported devices. Reverse Proxy Servers cannot be used to deliver MCM Client Installation Files to 
mobile devices. 

ShoreWare supports most available Reverse Proxy Server products. Appendix E in the Planning and Installation Guide 
describes the implementation procedure for an Apache Server installed on a Windows 2003 Server.

Client Installation Files
Installing the ShoreWare Server places the MCM Client Installation Files directly on the ShoreWare Server. BlackBerry devices 
can access the files directly from the ShoreWare Server if the network includes a BES.

Client Installation files can be delivered from a system that runs Windows 2003 Server and has IIS (version 5.0 or later). The 
IIS server must be configured to serve WML (Wireless Markup Language) files to the mobile devices. Figure 12 lists the MIME 
types required to serve the installation files:
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Registering MIME Types
To register the required MIME types:

1. Open the Administrative Tools panel by clicking the Windows Start button and selecting Settings -> Control
Panel -> Administrative Tools.

2. Open the Internet Information Services panel by clicking on the Internet Information Service icon.

3. Open the HTTP Headers page, shown in Figure 13, by clicking the HTTP Headers tab at the top of the Internet
Information Services panel.

4. Open the MIME Types panel by clicking the MIME Types... button in the bottom right corner of the HTTP
Headers page.

5. Open the MIME Types Dialog box by clicking the New button on the top right corner of the MIME Types panel,
as shown in Figure 14.

6. Enter the Associated extension and content type data in the corresponding data entry field of the MIME Types
Dialog box, shown in Figure 15, for one of the following types:

• Content type: text/vnd.sun.j2me.app-descriptor; Associated extension: .jad

• Content type: application/java-archive; Associated extension: .jar

• Content type: text/vnd.wap.wml; Associated extension: .wml

• Content type: application/vnd.rim.cod; Associated extension: .cod

7. Click the OK button to close the MIME Types dialog box and return to the MIMES type panel

The table lists the type entered in step 6.

File Extension MIME Type
.jad text/vnd.sun.j2me.app-descriptor
.jar application/java-archive

.wml text/vnd.wap.wml
.cod application/vnd.rim.cod

Figure 12 Mime Types required to serve MCM Installation Files

Figure 13 Internet Information Services panel – HTTP Headers page
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8. Repeat step 5 through step 7 for each type listed in step 6.

9. Click OK buttons on each successive panels to save your changes and return to the desktop.

ShoreWare Director Configuration

Licenses
One ShoreWare Mobile Call Manager Keyed License is required for each client that is enabled for ShoreWare Mobile Call 
Manager. To view the number of ShoreWare Mobile Call Manager licenses available on your system, open the Director License 
Requirements panel, shown in Figure 16 by selecting Administration -> System Parameters -> Licenses -> Requirements from 
the Director menu.

Client Authorization
ShoreWare administrators grant ShoreWare Mobile Call Manager access to clients through ShoreWare Director. To enable 
ShoreWare Mobile Call Manager access for a ShoreWare user:

1. Access the Individual User list by selecting Administration -> Users -> Individual Users from the Director
menu.

2. Open the Edit User panel for the desired user by clicking the name of the user in the User List.

3. Verify that General is selected in the Properties bar located at the top of the Edit User panel.

The Allow Mobile Call Manager parameter is located on the lower section of the panel, as shown in Figure 17.

4. Select the Allow Mobile Call Manager check box.

5. Verify that (Voice Mail Password) Must Change on Next Login is cleared, as shown in Figure 17.

6. Set the Prompt for Password parameter to specify the PIN entry frequency for the user

Figure 14 MIME Types panel

Figure 15 MIME Types dialog box
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• First Time Only requires the user to enter the PIN only during the user’s initial ShoreWare Mobile Call
Manager access.

• Always requires the user to enter the PIN on each ShoreWare Mobile Call Manager access.

Client Configuration Information Delivery
The administrator must provide the following information to each client authorized to use ShoreWare Mobile Call Manager:

• URL of the server through which the mobile device can download the Client Installation Files

• IP address and Port Number through which the mobile device accesses the MCMS

• the client’s user extension

• the client’s voicemail password

Client Configuration
ShoreWare Mobile Call Manager client software is installed into the mobile device, then configured to communicate with the 
Mobile Call Manager Server.

Downloading Files
To install the ShoreWare Mobile Call Manager client software on a mobile device:

1. Open a browser on the mobile device.

2. Enter the IP address or URL of the server that downloads MCM Client Installation Files. 

The administrator must provide this address to the client.

3. Click the Go button.

Figure 16 License Requirements page
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Logging onto ShoreWare Mobile Call Manager
After installing the ShoreWare Mobile Call Manager client application on the mobile device, the end user accesses the 
application from the Application menu by selecting the ShoreTel icon. The client’s voicemail PIN is used as the PIN.

The Side Convenience Key on the BlackBerry 8700 can be programmed to open ShoreWare Mobile Call Manager.

Initial ShoreWare Mobile Call Manager Access
The first time a client opens ShoreWare Mobile Call Manager after installing the program, the device prompts for the following 
information:

• The IP address of the server through which the mobile device can access the MCMS

• The port number of the server through which the mobile device can access the MCMS

• The client’s extension

• The client’s PIN

When ShoreWare Mobile Call Manager is properly configured, the device displays the “Welcome to the ShoreWare Mobile Call 
Manager Application” panel. Press the scroll button , then click Next to display the Main Menu.

Figure 17 Configuring an End User for ShoreWare Mobile Call Manager
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Integrating Address Book Contacts
When a BlackBerry logs into ShoreWare Mobile Call Manager, the device provides an option that allows the user to include 
contacts stored locally on the BlackBerry when performing QuickDialer operations. The opening panel lists the following 
question: “The application ShoreWare Mobile Call Manager has attempted to read your user data. Would you like to allow 
this?”, followed by Yes and No options.

• If the user clicks Yes, all QuickDialer queries will return appropriate entries from the user’s ShoreWare address 
book and the BlackBerry address book.

• If the user clicks No, all QuickDialer queries will return appropriate entries only from the user’s ShoreWare 
address book.

When the user selects Yes, ShoreWare Mobile Call Manager loads the BlackBerry contact information, where it is accessed 
through QuickDialer operations. Large BlackBerry address books may take several seconds to load; when the user attempts to 
use QuickDialer before the BlackBerry contact information is loaded, the query will return entries from only the ShoreWare 
address book.

The BlackBerry 8700 can execute ShoreWare Mobile Call Manager in the background while actively performing other tasks. 
Running ShoreWare Mobile Call Manager in the background while actively running another program maintains the BlackBerry 
contact information in memory. Pressing the End button returns the BlackBerry display to the menu panel while running 
ShoreWare Mobile Call Manager in the background.

Version Control
When a client logs into ShoreWare Mobile Call Manager, the server compares the client and server versions to verify that they 
are compatible. ShoreWare Mobile Call Manager defines three compatibility levels:

• Current – The client and server are running the same version. The client application runs with no problems.

• Compatible – The client and server are running different, compatible software versions. The client receives a 
message that, while an upgrade is recommended, the client can continue using the application.

• Incompatible – The client and server are running different, incompatible software versions. The client must update 
the software before running ShoreWare Mobile Call Manager.

Resetting Client Information
Resetting the ShoreWare Mobile Call Manager configuration removes the client’s information from the mobile device. After 
resetting the configuration, a client must perform the initial ShoreWare Mobile Call Manager access procedure listed in Initial 
MCM Access to access ShoreWare Mobile Call Manager features on the device.

Configuration information in the mobile device persists when the device is turned off. When the device is subsequently powered 
up, the application does not require reentry of the end user’s extension and password to access ShoreWare Mobile Call Manager 
features, account settings, and the end user’s information.

Configuration Options
The Settings panel, accessed by selecting Settings from the Main Menu, provides the device configuration and account 
parameter setting options:

• Call Handling Modes: This menu sets parameter values for the client’s call handling modes.

• Office Anywhere: This menu specifies the Office Anywhere external number.

• Default Start Page: This menu specifies the initial panel displayed by the device when the end user opens 
ShoreWare Mobile Call Manager.

• Network Speed: This menu determines the amount of data the mobile device retrieves in one transmission when 
the end user requests a QuickDialer, Voicemail, or Call History update. When this parameter is set to slower speeds, 
the device receives less information to minimize the time the client waits for the update:

— Low (Slow 2/2.5G/CDMA) – device receives 10 entries from server
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— Medium (Fast 3G) – device receives 25 entries from server

— High (High Speed/Wi-Fi) – device receives 100 entries from server

Users can request more entries by selecting Update on the appropriate menu.

• Reset: This option removes the user’s ShoreWare Mobile Call Manager information from the device.

Using the Device

Main Menu
The Main Menu displays client status and provides links for navigating to Voicemail, Call History, QuickDialer, and 
Configuration panels.

ShoreWare Mobile Call Manager displays the following status information at the top of the Main Menu:

• Number of unheard voice message in the client’s mailbox

• Number of missed calls

• Office Anywhere activity setting

ShoreWare Mobile Call Manager displays the active call handling mode at the bottom of the Main Menu.

Making Calls Through ShoreWare Mobile Call Manager: Setting Office Anywhere
The ShoreWare Mobile Call Manager program operates separately from the mobile devices normal calling mechanism. When 
ShoreWare Mobile Call Manager is active, the device maintains its ability to send and receive calls independent of ShoreWare 
Mobile Call Manager.

When Office Anywhere is set to Home Assignment, calls initiated through ShoreWare Mobile Call Manager on the mobile 
device are completed through the ShoreTel IP phone that the system associates with your extension. To route ShoreWare 
extension calls through the mobile device, Office Anywhere must be set to External Assignment, with the External Number 
set to that of the mobile device.

To change the Office Anywhere setting to External Assignment:

• Navigate to the Main Menu, press the scroll button and select Set Office Anywhere

To change the Office Anywhere parameters:

• Access the Office Anywhere panel by selecting Settings -> Office Anywhere from the Main Menu.

QuickDialer
QuickDialer is a tool that displays contact information and initiates phone calls without requiring entry of the complete contact 
name or number.

Phone Number Retrieval
An end user performs a QuickDialer retrieval by entering a set of alphanumeric characters, then initiating an update. The device 
responds by displaying entries whose First Name, Last Name, extension number, or external contact number match the entered 
characters. The number of entries that the device initially receives depends on the Network Speed setting.

To retrieve additional, available entries:

• Press the cursor button and select Update

Calling a Retrieved Number
To initiate a call:

• Scroll to the desired number, press in the right scroll button and click the Call soft button

Phone Number Directory Scope
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• QuickDialer merges the client’s mobile device directory with the ShoreTel system directory when providing an 
entry list.

Microsoft Outlook contacts accessible through the client’s desktop application are not included in an ShoreWare Mobile Call 
Manager retrieval.

Voicemail
The Voicemail message list displays the client’s mailbox contents and the following information for each message:

• Folder (Inbox and Unheard, Inbox and Heard, Saved)

• Caller ID (name and number, if available)

• Time of receipt

• Duration

• Heard status

The list displays a voicemail icon with each message. A grey icon indicates that the message has been heard. A
normal icon indicates an unheard message.

The Messages are listed in the order they are received, with the most recent message on top. The ShoreWare Mobile Call 
Manager checks the voicemail server for new messages and updates the list displayed on the client’s handset. The number of 
entries that the device initially receives depends on the Network Speed setting.

To retrieve additional, available entries:

• Press the cursor button and select Update

The following actions are available for the selected message:

• Play Preview: This action plays the first few seconds of the message on the mobile device.1

Previewing a message does not change the heard status of the message.

• Play: This action plays the message on the mobile device or the device assigned to the extension.

• Call Sender: This action initiates a call to the address from where the message was sent.

This action is available only from messages that are associated with a valid Caller ID.

• Delete: This action moves the message to the Deleted Items folder of the client’s mailbox.

Messages in the Deleted folder can be recovered to the folder from where they were removed. To permanently
remove a message, delete it from the Deleted folder.

Call History
This call history screen displays the ten most recently received calls by the extension, with the most recent call listed first. The 
display sorts the received calls, dialed calls, and missed calls into separate lists. 

Each entry provides the following parameters about the corresponding call:

• Caller ID (name and number, if both are available)

• Time of Call

• Duration of Call 

• Caller Name (if Available)

To dial the contact specified by a call history entry:

1. Note that this functionality is not supported on the BlackBerry 7290.
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• Select the desired call and click the Call soft button.

Call Handling Mode operations
You can change all call handling mode parameters and set the active call handling mode from ShoreWare Mobile Call Manager.

To configure a call handling mode:

• Select Settings -> Call Handling Modes from the Main Menu.

To set the active call handling mode:

• Navigate to the Main Menu, press the scroll button, and select Set Call Handling Mode.
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Call Center Integration

Overview
ShoreTel integrates Contact Center Agent Toolbar functionality into Call Manager, allowing end users to control their Contact 
Center state and access Contact Center functions and Call Manager operations from a single, unified interface.

Background
Figure 18 displays the non-integrated Contact Center Agent Toolbar. This interface allows Contact Center users to program 
buttons on the Agent Toolbar by assigning common functions and call center operations to the various buttons. Users can 
perform the desired operation with the click of a button.

Requirements
Contact Center agents can access Contact Center through Call Manager only on PCs upon which Contact Center Agent Toolbar 
and Call Manager are installed.

Contact Center Supervisors can access Contact Center through Call Manager only on PCs upon which Contact Center Agent 
Toolbar, Contact Center Supervisor Applications, and Call Manager are installed.

To use Call Manager for performing Contact Center operations, a Contact Center Supervisor must also be configured as a 
Contact Center Agent.

For complete information on configuring Contact Center components, refer to Contact Center documentation.

Description
Contact Center functions are intgrated into Call Manager by assigning Contact Center operation buttons into Programmable 
Toolbars. Each toolbar can contain 24 buttons. To display additional buttons beyond those normally visible, click the arrow icon 
on right side of the toolbar. Figure 19 displays a Call Manager toolbar that contain Contact Center function buttons.

Details:
• Up to 24 buttons can be programmed in a single Call Manager toolbar.

• Toolbars can be created on a per-user basis or on a global basis. Toolbars created at the global level can be deployed 
to multiple users in the system.

• Three global toolbars maybe be deployed per User Group, with a maximum of 100 per system.

• Six personalized toolbars can be created for each user.

• A single user can employ 3 global toolbars, in addition to 6 personalized toolbars, for a total of 9 toolbars. With 24 
buttons per toolbar, this allows a user to deploy a total of 216 programmable toolbar buttons. (24 buttons per toolbar 
X 9 toolbars  = 216 buttons)

Figure 18 Contact Center Agent Toolbar
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Accessing Contact Center Agent Toolbar Functions
The table below lists the various operations available in Contact Center and provides the new name for the operation in the 
integrated Call Manager (if applicable). Any operations that do not appear listed in the Contact Center Agent Toolbar column 
(in the middle of the table) do not have an analogous function in the integrated Call Manager. In many instances, this operation 
does not have an analogous operation in the integrated Call Manager because the Contact Center operation can be performed 
using one of the pre-existing functions available in the regular (i.e. non-integrated) Call Manager product.

Figure 19 Call Manager Toolbar containing Contact Center operation buttons

Contact Center Operation Name Operation Button or Path in Call Manager

Telephony Operations

Answer Answer Call Center Call

Set Callback - Reinsert Busy Reinsert Busy Call

Set Callback - Reinsert No Answer Reinsert Unanswered Call

Set Callback - Reinsert Terminate Reinsert Terminated Call

ACD Operations

Groups Manager Select Contact Center -> Agent Manager from Call Manager

Login Primary Groups Login Primary Groups

Logout from Primary Groups Logout Primary Groups

Login Group Login Group

Logout Group Logout Group

End Wrap Up (Ready) End Wrap-Up

Release with Code Release With Code

Resume/ Release Resume/Release

Supervisor Help Supervisor Help

Transfer to Agent Blind Transfer Agent

Wrap-Up Code Wrap-Up Code

Wrap-Up Manual Control Extend Wrap-Up

Accessing Applications Windows

Desktop Wallboard Select Contact Center -> Desktop Wallboard from Call Manager

Figure 20 Call Manager access methods to Contact Center operations
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Implementation

Configuring Director
To configure integrated Call Manager – Contact Center for a user: 

Step 1 Launch ShoreWare Director and enter the user ID and password. Then click the Login button.

Step 2 Click on the Administration link to expand the list (if it has not already been expanded).

Step 3 Click on the Users link and then click on the Individual Users link.

Step 4 Click on the name of the user whose toolbar you would like to configure. 

Step 5 Select Enable Contact Center Integration, as shown in Figure 21.

Call Status Select Contact Center -> Call Status from Call Manager

Queue Calls Select Contact Center -> Queue Calls from Call Manager

Agent Log Select Contact Center -> Agent Log from Call Manager

Contact Center Reports Select Contact Center -> Contact Center Reports from Call Manager

Other Operations

Pop-up window as client is launched Set Agent ID

Execute an Application Run Contact Center App. (or execute from Command Line)

Contact Center Functions Not Available in Call Manager

Divert Incoming Call

Manage List of Login / Logout ACD Groups

Open Telephony Window

Chat Tree

Figure 21 Selecting the Contact Center client type

Contact Center Operation Name Operation Button or Path in Call Manager

Figure 20 Call Manager access methods to Contact Center operations
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Step 6 Click Save to store your changes.

Next, configure the programmable buttons for this user.

Step 1 Click on the Personal Options tab for the user who’s system you are configuring, and then click the Program
Personal Call Manager Toolbars link. 

Step 2 On the Program Personal Call Manager Toolbar window, click the New button to display a window similar
to the following:

Step 3 Enter a name for the toolbar and then click on the Function drop-down menu and select Contact Center.

Step 4 Then, select the desired operation from the drop-down menu. This operation will be associated with this
specific toolbar button.

Step 5 Enter a label in Label field.

Step 6 If the function requires Target information, the required fields will appear to the right of the function. Enter
the appropriate information as required for the type of operation the button will be performing. (For
example, if the desired operation is Blind Transfer Agent, then an Agent ID field would appear in the Target
area, allowing you to enter this information.)

If the target field for certain operations is left blank or is configured with invalid information, this will cause
the operation to open a pop-up dialog box to collect more information (or valid information) when the user
clicks on the associated button in Call Manager. This behavior applies to the following operations:

• Consult Transfer to Agent

• Blind Transfer to Agent

• Login/Login Group

• Logout Group

• Release with Reason Code

• Wrap-up with Code

Step 7 Continue programming the toolbar buttons as desired.

If a button is left unused or blank and this unused button is between other used buttons, Call Manager will
interpret the sequence of blank buttons as a divider that will be visible on the toolbar.

Step 8 Once you have finished configuring the toolbar programmable buttons, click Save to store your changes.

Figure 22 Assigning Contact Center operations to Call Manager Toolbar buttons
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Details
• Once you have finished the configurations described above, you can repeat this process of assigning operations to 

buttons for each new user that will be using the integrated Call Manager. 

• When finished configuring buttons for each new user, follow the procedure below to configure the Call Manager 
clients.

Configuring Contact Center Options through Call Manager
To configure the Call Manager Contact Center options, perform the following:

Step 1 Open Call Manager. The panel in Figure 23 appears the first time Call Manager is opened after integrated
Call Manager is enabled for the user.

The Setup window is configured once. If it has not been configured, the Agent Toolbar opens this dialog
the first time it is executed. This dialog box offers a manual way to enter IP addresses or mail account
information. 

• Server IP – The address of the Contact Center Server

• Local IP Address – The address of the agent’s client machine

• Mail Account – The Personal Email Username for Contact Center – not an email address. Refer to
the ShoreTel Contact Center Administration Guide.

Mail Accounts allows agents to receive email from callers through standard email programs, such as
Outlook or Outlook Express. Email accounts are configured for each inquire type and email received
in these accounts are placed in a queue where an agent can download a predetermined number of
emails. Mailboxes can be assigned to a specific computer or agent.

• Mail Password – this is the agent’s password that is associated with the Personal Email Username

Step 2 Verify the information in the setup window, then select Contact Center -> Configure Call Center from the
Call Manager main menu.

Call Manager displays the Contact Center Options panel shown in Figure 24.

Step 3 Click on the Configure Groups button from the Contact Center Options window to display the Group
manager window shown in Figure 25.

Step 4 The Group manager window allows you to log into or out of select contact center groups. To log into a
group, click a group name from the “Available Groups” pane (on the right) to highlight it. Then, click the
Login button to move that group to the “Logged Groups” pane on the left.

Step 5 Next, click the Configure Call Status button from the Contact Center Options window to display a window
similar to the one shown in Figure 26.

Figure 23 Configuring the IP addresses for the Agent Toolbar
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Step 6 This window allows you to determine which blocks of information will appear in the agent Call Status
window (shown on the next page). Click any of the parameters from the “Available Fields” pane on the
right, and then click the << button to move the selected parameter to the “Selected Fields” pane on the left.

The agent Call Status window displays information about a current call that has been answered by this
agent. Information is displayed with the selected fields listed across the top, as shown in Figure 27.

Figure 24 The Contact Center Options window

Figure 25 Logging into and out of workgroups

Figure 26 Selecting parameters for display
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The Call Status window can display information for multiple calls. The window displays information about
how long the caller has been waiting, the priority of the call. And if the agent belongs to multiple groups,
the window will provide information about which group the call originated from.

Step 7 Next, click the Configure Queue Monitor button from the Contact Center Options window. The dialog box
used to configure the Queue Calls window is essentially the same as that shown in Figure 26 for configuring
the Call Status window. You should select click the desired parameters from the “Available Fields” pane
and move them to the “Selected Fields” pane on the left.

After the configuration is selected, the Queue Calls window appears, as shown in Figure 28.

The Queue Monitor is similar to the Agent Call Status window in that it provides information about
incoming calls, but it is different in that it displays information for calls that have not been answered. An
additional difference is that the Queue Calls window allows users with the proper permissions, as defined
in the Class of Service, to double-click a particular call to answer it.

Step 8 Select the Show Agent Toolbar check box from the Contact Center Options window to display the Contact
Center Agent Toolbar, similar to the one in Figure 29.

The Agent Toolbar offers an optional method of accessing the Contact Center features and application
windows. Because the Agent Toolbar offers access to many of the same functions and features as the
integrated Call Manager window, having both open at the same time may be redundant and unnecessary,
but it can ease the transition from Contact Center to the new unified interface.

Figure 27 Call status fields in the Agent Toolbar

Figure 28  Queue monitor

Figure 29 Agent Toolbar functions



ShoreWare Server Software Release Notes Call Center Integration

24 July 2008 Page 37

Details:
• Depending on how the programmable buttons were configured, many of the functions shown in the Agent Toolbar 

in Figure 29 are the same as those that appear in the integrated Call Manager and Contact Center user interface.

• Supervisors can access certain capabilities by clicking on the highlighted buttons shown in Figure 29. 

• The following functions can be performed from the Agent Toolbar:

— Telephony Operations

— ACD Operations

— Application Windows

— Chat Operations

— Other Operations

Contact Center Feature Limitations in Call Manager
The Contact Center Agent Toolbar includes a status bar, shown in Figure 30, that displays caller and call status information. 
Status bar information is not available through Call Manager. Information displayed by the status bar that is not available 
through Call Manager includes:

• Type of call the agent is servicing: voice call, email interaction, or chat interaction.

• Call Profile information collected from the IVR or configured in Contact Center. The Call Status window in Call 
Manager displays the Call profile fields.

• Indicators that an agent is scheduled for an outbound call programmed by Contact Center Dial Lists, abandoned 
callbacks, and scheduled callbacks. 

• When Agent Notification Preview is enabled in Contact Center, Call Manager receives notification of programmed 
call sbefore they are placed.

Call manager does not have ring tone options to distinctly identify the inbound call type on the agent desktop. Call manager 
signals an incoming Contact Center call in the same manner as all other calls.

Contact Center upgrades for the agents and supervisors are distinct from Call Manager upgrades for new software releases. 
Version updates for new Contact Center releases that require an update for agents and supervisors must be performed as 
described by Contact Center installation documentation and are not affected by Call Manager upgrades.

Using the Integrated Call Manager/Contact Center
To access the workgroups login feature (and other functions), you can use the Contact Center menu in Call Manager:

Step 1 Select Contact Center -> Login Primary Groups to login into the primary groups. 

If you are already logged in, you can select Logout Primary Groups to exit from the primary groups of which
you are a member. This operation can be assigned to a Call Manager programmable button

Step 2 Verify that you successfully logged into a contact center group by viewing the Logged In icon in the Status
bar, as shown in Figure 31.

Figure 30 Status Bar in Contact Center Agent Toolbar
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• If you are not logged into at least one contact center group, the login icon states Logged Out. 

• If a problem occurs while logging into the contact center, the status bar displays System Unavailable.

Figure 31 displays Call Manager and the Contact Center toolbar when receiving a Contact Center call.

Figure 31 Receiving Contact Center Call Through Call Manager
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Paging Extension in Paging Group

Synopsis
This feature allows Paging Groups to include paging extensions. This allows a user to send a page announcement to the 
overhead page systems of multiple sites simultaneously.

Background
A Paging Extension is an extension which, when dialed, sends a page announcement to a site’s overhead paging system. Each 
site can have a maximum of one paging extension.

A Paging Group defines an extension which, when dialed, triggers a page announcement to all extensions in a specified 
Extension List. 

Including Paging Extensions into a Paging Group allows a caller to send page announcements simultaneously to the overhead 
system of one or more sites and to all other extensions in the Extension List specified by the Paging Group.

Description
Paging Group membership is defined by the extension list associated to a paging list. Adding a Paging Extension to an extension 
list provides simultaneous access to the site’s overhead paging system along with all other extensions in the Extension List. 
Adding multiple Paging Extensions to an Extension List provides the capability to simultaneously page the overhead paging 
system of multiple sites.

To add a Paging Extension to an Extension List

1. Access the Extension List table by selecting Administration -> Users -> Extension Lists from the Director menu

2. Open the Edit Extension List page by clicking the name of the Extension List to which the Paging Extension will 
be added.

The list in the bottom left corner of the page displays the extensions that are available to the Extension List. In
Figure 32, the selected extension in this list is a Paging Extension.

3. Select the Paging Extension and press the Add button located between the two lists.

4. Press the Save button at the top of the page to save the Extension List changes.

Figure 32 Adding a Paging Extension to an Extension List
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To associate the extension list with a paging group:

1. Access the Paging Group List by selecting Administration -> Call Control -> Paging Groups from the Director 
menu.

2. Open the Edit Paging Group page for the desired group by clicking the group’s name in the Paging Group List.

Figure 33 displays the Edit Paging Group page.

3. Select the Extension List that contains the paging extension from the Extension List drop down menu at the 
bottom of the panel.

4. Press the Save button at the top of the page.

Figure 33 Associating an Extension List with a Paging Group
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Synchronize Group Paging

Synopsis
This feature synchronizes the way the media is played across a group of phones such that all devices that receive a paging 
message play the announcement simultaneously.

Background
Group paging is a ShoreWare feature that broadcasts page announcements to a pre-defined set of extensions called a paging 
group. When group paging is not synchronized, the network my cause a time lag between the playing of the page announcement 
across several devices, causing an echo effect. Messages subject to this echo effect are difficult to understand.

Description
The workgroup server synchronizes group paging by introducing a pause after receiving a group page request, allowing calls 
to all affected extensions to connect. The maximum pause duration is six seconds. The server begins playing the message either 
after all calls are connected or six seconds after receiving the page request.

The synchronization of group paging can be overridden through a registry setting.
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Voicemail Password Aging

Synopsis
The Voicemail Password Aging feature configures TUI passwords with the ability to expire after a specified period. When a 
system administrator enables password aging, the system prompts and requires each ShoreWare client to change their TUI 
password after a specified period from the time that the password was most recently changed.

Background
Previous ShoreWare versions do not force users to change their TUI passwords after the initial login. Requiring periodic 
password changes increases the security of the system.

Description
The Password Aging feature applies to the following Dialed Number types:

• User extensions

• Workgroup extensions

• Route point extensions

• External user extension

Passwords are associated with two timing parameters: Warning and Expiration

• Warning specifies the number of days, measured from the last password change, after which the system begins
prompting clients to change their passwords.

• Expiration specifies the number of days, measured from the last password change, after which clients are
required to change their passwords before they can access voicemail.

When the Warning and Expiration periods have not elapsed, users do not receive any prompts to change their passwords. When 
the Warning period elapses, users receive prompts to change their passwords but are allowed to access their voicemail if the 
Expiration period has not elapsed. After the Expiration period elapses, users are required to change their passwords before they 
can access voicemail.

Users are not permitted to enter their current password as a new password. Entering a current password as a new password 
generates a prompt for a different password.

Implementation
Administrators can configure password warning and expiration periods for Voice Mail Classes of Service. To access password 
aging parameters, open the Edit Voice Mail Permissions panel, shown in Figure 34, by selecting Users -> Class of Service 
from the ShoreWare Director menu, then click on the name of the desired Voice Mail Class of Service. 

• To enable the mailbox password expiration period for group members assigned to a Class of Service, place a
mark in the Lifespan of Voicemail Password (30-365) selection box, then enter the number of days during which
a password remains valid in the data entry field. Value entries range from 30-365; default value is 90 days. The
default value of the selection box is unmarked.

• To enable the mailbox password warning period for group members assigned to a Class of Service, place a mark
in the Days in Advance of Password Expiration Before Warning (1-30) selection box, then enter the number of
days (prior to the password expiration), at which point group members will begin receiving warning messages. If
the selection box is not marked or if 0 is placed in the data entry field, password expiration warning messages are
not delivered to the group member.
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The Warning parameter cannot be set if the Lifespan of Voicemail Password parameter is not enabled.

Figure 34 Class of Service panel – Password aging parameters
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Selectable Mailboxes (Call Recording Enhancement)

Synopsis
This feature enhancement allows the automatic placement of recorded calls into mailboxes other than that of the client who 
initiated the call recording.

Background
IP Phones and Call Manager buttons have long had the ability to be programmed to record calls. However, previous releases 
allowed the designation of only one destination mailbox for all recordings initiated by a user. Although multiple buttons could 
be programmed to record calls, all recordings were saved in the same voice mailbox.

The Selectable Mailboxes feature is an enhancement that permits the designation of a different voice mailbox for each button 
programmed to record calls. Each button that initiates a call recording can be independently associated with a different voice 
mailbox.

This feature is available for Record Call (end users recording their own calls) and Record Extension (end users recording calls 
from other extensions) functions.

Configuration
Note: End users must belong to a Telephony Class of Service that allows the Recording of Own Calls (Record Call function) 
or Record Other’s Calls (Record Extension function). For more information, see the “Classes of Service” section in chapter 10 
of the ShoreTel Administration Guide.

Configuring IP Phones Buttons from Director
To configure an IP Phone button to save call recordings in a mailbox other than that of the initiating client, follow the 
instructions below:

1. Launch ShoreWare Director and enter the user ID and password. Then click the Login button.

2. Click on the Administration link to expand the list (if it has not already been expanded).

3. Click on the Users link and then click on the Individual Users link.

4. Click on the name of the user whose programmable buttons you will be modifying. 

5. Click on the Personal Options tab, and then click on Program IP Phone Buttons link to display a window
similar to the one shown below: 

Figure 35 Record Client Calls and send to distant mailbox
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6. For the desired programmable button, click the Function drop-down menu and select Record Call.

7. Enter an appropriate name for this button in the Label field, and in the Target area, click the Search button and
select the name of the person who will be receiving the saved call recordings in their mailbox.

8. Click the Save button to store your changes.

For example, Figure 35 above shows that Button 2 on Adam Pierce’s phone has been configured to allow Adam
to initiate recordings of his own conversations and send them to Bonnie Hopkins’ mailbox.

9. However, if you wish to configure an IP Phone button to record calls on another extension (e.g. allow a supervisor
to record the calls of an agent), click the Program IP Phone Buttons link (referred to in step 5 above) to display
a window similar to the one shown below: 

Figure 36 Record Distant Extension calls and route to any mailbox

10. For the desired programmable button, click the Function drop-down menu and select Record Extension.

11. Enter an appropriate name for this button in the Label field, and in the Target area, click the Search button and
select the name of the person whose extension will be recorded.

12. Near the Mailbox field, click the Search button and select a target mailbox where call recordings will land. This
is an optional configuration. By defautl, if this Mailbox field is left blank, then call recordings will be sent to the
mailbox of the initiating party (i.e. Adam Pierce, in Figure 36).

13. Click the Save button to store your changes.

To summarize, Figure 36 above shows that Button 3 on Adam Pierce’s phone has been configured to record Evan
Wayne’s phone conversations. All recordings will be placed in Adam’s mailbox because the Mailbox field has
been left blank.

For instructions on configuring and using the selectable mailboxes feature (thus allowing clients to program this feature on their 
own IP phone buttons), please refer to the ShoreWare 7.5 Client Release Notes.
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Configuring IP Phone Buttons from the IP Phone
End users who are authorized to customize their IP phone programmable buttons can configure the recipient mailbox for Record 
Call and Record Extension functions on any IP phones that offer programmable button support.

To program an IP Phone Button for the Selectable Mailbox function:

1. Access the Options panel by pressing the Options button and entering your password.

2. Select Program Buttons from the Options Menu and press the Edit button.

3. Press the button that you wish to program.

4. Scroll down to Record Call or Record Extension, then press Next.

Enter function parameters as requested until the panel displays the Please enter a mailbox for the recording to
land or leave it blank prompt.

5. When you see the Please enter a mailbox for the recording to land or leave it blank prompt, enter the extension
of the client that is to receive recordings indicated by pressing the button.

When this option is not completed, recordings are placed in the phone user’s mailbox.

6. Finish the normal configuration procedure for the specified function.

Configuring PCM Toolbars
End users access Record Call and Record Extension functions in Call Manager through toolbar buttons. Each button 
programmed for these functions designates the mailbox that receives the call recording file at the conclusion of the call. End 
users can use these functions only if they have access to toolbars that include Record Call or Record Extension buttons. Clients 
cannot program Toolbar buttons to specify recording recipients.

When a selectable mailbox field does not specify a recipient mailbox, the default entry is specified in Director by the Voice 
Mailbox for Recorded Calls setting on the Edit User Personal Options panel.

To program a Toolbar button for an selectable mailbox:

1. Open the ShoreWare Director panel for the desired PCM Toolbar by selecting Program Personal Call Manager
Toolbars from the Personal Options page of the selected client’s Edit User panel. 

Figure 37 displays the Edit Global Toolbar panel. Global Toolbars are accessed from Personal Call Manager ->
Global Toolbars in the Director Menu.

2. Select Record Call or Record Extension for a programmable button

A Mailbox option field is displayed to the right of the label field.

Figure 37 Record Call Mailbox Selection fields for PCM Toolbar buttons



ShoreWare Server Software Release Notes Selectable Mailboxes (Call Recording Enhancement)

24 July 2008 Page 47

3. Enter the required information in the Mailbox option field:

• To route recordings to the initiating client’s default mailbox, leave this field blank.

The default mailbox is specified by the Voice Mailbox for Recorded Calls setting on the Edit User Personal
Options panel for the recording initiator.

• To specify a recipient mailbox for this client’s call recordings, press the Search button and click the recipient’s
name in the popup.

When you specify Record Extension, the mailbox field located below the Extension field designates the recipient mailbox for 
call recordings initiated by pressing this programmable button.

In Figure 37 the Global Toolbar panel configures the following Advanced toolbar buttons:

• Button 1 is configured to send recordings initiated to the End User’s default recording mailbox, as specified by the
empty Mailbox data entry field. 

The default mailbox is specified by the Voice Mailbox for Recorded Calls setting on the Edit User Personal
Options panel for the recording initiator.

• Button 2 is configured to record Maude Fremont’s calls and place the recording in Mathilda Miller’s mailbox.
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Send Server Logs

Synopsis
This feature provides utilities for automating the collection of server logs, Windows (OS) logs, and ShoreWare databases. The 
utilities include a graphical application and a command line application. Both applications have the same functional capabilities.

Background
ShoreWare stores server log files that record event information about all system transactions. Technical Support personnel use 
these logs to diagnose and resolve issues that arise during system operation.

In previous ShoreWare versions, manual file operations are the only available method of collecting server logs. This feature 
provides a menu interface for selecting the required logs. 

Description
This feature provides Graphical and Command Line applications for collecting system server logs.

Graphical Application
The graphical application can be executed from MS Windows or from a command window. The following program launches 
the Graphical version of the Server Log Collection Utility:

<ShoreWare install directory>\slogWin.exe

where <ShoreWare install directory> is the location of the ShoreWare server files. The default installation location 
of ShoreWare server files is

C:\Program Files\Shoreline Communications\ShoreWare Server.

Panels provide Next and Back buttons for navigating through the process. You can terminate the program at any time by 
pressing the Cancel button

Banner Panel
The Server Log Utility displays the Banner panel, shown in Figure 38, when you execute the Graphical Application. Press the 
Next button to proceed to the Date Selection panel.

Figure 38 Graphical Server Log Utility – Banner panel
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Date Selection panel
The Date Selection panel, shown in Figure 39, specifies the dates for which the log files are collected. The program collects 
files only for a contiguous date set. The default selection is today’s date.

• To select today’s date, press the Next button without modifying the panel contents.

• To select a single date, click on the desired date with the mouse cursor.

• To select a date range, click and hold on the first day in the range, then drag the cursor to the last day in the range.
The maximum range is seven days.

Press the Next button to proceed to the Log Selection Method panel.

Log Selection Method panel
The Log Selection Method panel, shown in Figure 40, specifies the log file selection method and the destination directory.

Log Selection Method

• To select all log files for inclusion in the archive, select the Default radio button. 

Figure 39 Graphical Server Log Utility – Date Selection panel

Figure 40 Graphical Server Log Utility – Log Selection Method panel
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Press the Next button while Default is selected to begin archiving all available log files.

• To manually select the desired log files for inclusion in the archive, select the Custom radio button. 

Press the Next button while Custom is selected, to open the Log Selection panel. This panel prompts you to select
the log files for inclusion in the archive.

Destination Directory Selection

The destination directory is listed above the Browse button.

• To select the Destination Directory, press the Browse button

The program opens a Browse for Folder panel for selecting the Destination directory.

Log Selection panel
The Log Selection panel, shown in Figure 41, specifies the log files that the program archives. The utility does not display this 
panel if you select Default in the Log Selection Method panel.

The four options at the top of the panel select multiple log files. When you select one of these options, all log files included by 
that selection are selected and cannot be edited. Select ALL to include all files in the archives.

All available log files are listed below the first four options at the top of the panel. You can select one file, all files, or any 
combination of files. Available log files include:

• Windows Logs
TMS ACC IPCS DataServices
SoftSw CSIS IPDS Director
DTAS CDR Database Voicemail
TAPI DRS Trigger WorkGroup Server

• All ShoreTel Logs
Crash Dump
NT Event Logs

• All ShoreTel DBs
CDR DB (Current) Config. DB (Current)
CDR DB (Previous) Config. DB (Previous)

Press the Next button to begin saving log files.

Figure 41 Graphical Server Log Utility – Log Selection panel
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Archiving Panel
The utility displays the Archiving panel, shown in Figure 42, while the program1 saves the selected files. The Next and Back 
buttons are disabled while the program is saving the files. The Cancel button remains available.

Press the Next button after the Save process is completed to display the FTP Upload panel.

FTP Upload panel
After archiving the files, the program presents an option to upload the archive file to a remote FTP server, as shown in Figure 
43. Enter valid settings for all FTP parameters, then press the Upload button.

Press the Next button to proceed to the Completion panel

1. Parts of the 7-Zip program, licensed under GNU LGPL, are used to compress and create archive files. For more information, please
see the following website: www.7-zip.org

Figure 42 Graphical Server Log Utility – Archiving panel

Figure 43 Graphical Server Log Utility – FTP Upload panel
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Completion Panel
The Completion panel, shown in Figure 44, indicates that the log files were successfully archived to the specified directory.

Press the Finish button to close the utility.

Command Line Application
The Command Line version of the Server Log Collection Utility provides the identical functionality as the Graphical application 
from the windows command prompt. The following program launches the Command Line version of the Server Log Collection 
Utility:

<ShoreWare install directory>\ServerLog.exe

<Shoreware install directory> is the location of the ShoreWare server files. The default installation location of ShoreWare 
server files is C:\Program Files\Shoreline Communications\ShoreWare Server.

The following is a complete set of available command line parameters:

ServerLog.exe  [-d1 <date1>] [-d2 <date2>] [-CDRDB] [-CONDB] [-CRASH] [-NTEL] [-TRIG] 
[-DB] [-DIR] [-DS] [-WGS] [-VM] [-IPDS] [-IPCS] [-DRS] [-CSIS] [-ACC] [-CDR] 
[-TAPI] [-DTAS] [-SS] [-TMS] [-ALLCONDB] [-ALLCDRDB] [-ALLWIN] [-ALLDBS] 
[-ALLLOGS] [-ALL] [-d <destDir>] [-f] [-v] [-h] [<path> <user> <pass>] 

WHERE:
-d <destDir> Set Destination Directory. This is a mandatory parameter.
-d1 <date1> Set Start Date. date1 = mmddyy.
-d2 <date2> Set End Date. date2 = mmddyy.

If -d1 is not specified, <date1> and <date2> are both set to the current date.
If -d1 is specified, -d2 becomes a mandatory parameter where <date2> must be greater than or equal to <date1> 

and less than (<date1> + 7 days). 
-CDRDB Retrieve current CDR Database Log
-CONDB Retrieve current Configuration Database Log
-CRASH Retrieve Crash Dump Logs
-NTEL Retrieve NT Event Logs
-TRIG Retrieve Trigger Logs
-DB Retrieve Database Logs
-DIR Retrieve Director Logs
-DS Retrieve DataServices Logs

Figure 44 Graphical Server Log Utility – Completion panel
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-WGS Retrieve Workgroup Server Logs
-VM Retrieve Voicemail Logs
-IPDS Retrieve IPDS Logs
-IPCS Retrieve IPCS Logs
-DRS Retrieve DRS Logs
-CSIS Retrieve CSIS Logs
-ACC Retrieve ACC Logs
-CDR Retrieve CDR Logs
-TAPI Retrieve TAPI Logs
-DTAS Retrieve DTAS Logs
-SS Retrieve SoftSwitch Logs
-TMS Retrieve TMS Logs
-ALLCONDB Retrieve All Configuration Database Logs
-ALLCDRDB Retrieve All CDR Database Logs
-ALLWIN Retrieve All Current Windows Logs (ShoreTel, NT Event, Crash Dump)
-ALLDBS Retrieve All ShoreTel Database Logs (CDR, Config)
-ALLLOGS Retrieve All Current ShoreTel Logs
-ALL Retrieve All retrievable logs and databases
-f Upload the archive to the specified FTP server
<path> <user> <pass> Specifies the FTP destination location when uploading the archive to an FTP server
-v Display version number of command line program, then exit
-h Display name and description of command line parameters, then exit

Example: The following command line copies Voice Mail logs generated between 2 March 2007 and 6 March 
2007 to C:\LogsDir directory: 

ServerLog.exe -d1 030207 –d2 030607 –VM –d “c:\LogsDir”

Example: The following command line copies all Voice Mail logs generated today: 
ServerLog.exe –d “c:\LogsDir”

Example: The following command line generates an error message because only one date is specified: 
ServerLog.exe -d1 030207 –VM –d “c:\LogsDir”
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Trace Route in ShoreTel Switches

Synopsis
ShoreWare 7.5 provides Trace Route in all available ShoreWare switches.

Background
Trace Route is a computer network tool that determines the route taken by packets from a source to a specified destination 
through an IP network. By sending a successive batch of packets with increasing TTL (time-to-live) values, Trace Route creates 
a map of hosts that a packet traverses to reach its destination. 

TTL is a packet variable that defines the number of “hops” (stations) that a packet can pass through before it expires. When a 
station receives a packet that has expired, it discards the packet and sends a time exceeded message to the originating station. 
Trace Route uses these expiration messages to build the path map.

Trace Route is a valuable network troubleshooting tool. By determining the path to a known destination, network technicians 
can identify firewalls blocking access to a site and gather information about the structure of a network and the IP address ranges 
associated with a host.

Description
Trace Route is available on all ShoreWare switches. The trace route command can be executed from the switch’s command line 
or from ipbxctl.exe. The only mandatory parameter is the destination IP address.

Executing Traceroute from the Switch’s command line
The following is the trace route command line and a complete set of available parameters:

traceroute "target IP address", "[-CeIS] [-m <max_ttl>] [-f <first_ttl>] [-l <length>] [-p <port>] 
[-q <nqueries>] [-t <tos>] [-w <waittime>] [-z <pausemsecs>]"

WHERE:
“target IP address” this parameter specifies the target IP address of the trace route. This parameter is mandatory.

IP addresses must be used and surrounded by quotes. DNS names are not supported.
-C probe on ShoreTel call control (ShoreSIP) port, using a ShoreSIP Request message, to determine if 

the packets flow from the switch through the network. This parameter uses fixed ports and 
version compatibility among all ShoreWare switches receiving packets.

-e specifies the use of a fixed destination port and an incrementing source port
By default, trace route increments the destination port with each probe. This port number is then 
used as a sequence number for matching packet responses to the probes. Incrementing the 
destination port number may complicate troubleshooting when packets are being filtered or lost 
at certain ports.

-I specifies ICMP protocol
UDP is the default protocol used for trace route 

-S specifies that probes are sent with a SIP message on the SIP destination port
Set this parameter to determine if SIP is flowing from the switch through the network. This 
parameter uses fixed ports.

-m <max_ttl> max_ttl specifies the maximum TTL value for trace route packets
default maximum TTL value is 30 bytes. Valid max_ttl values range from 1 to 255.

-f <first_ttl> first_ttl specifies the TTL value of initial trace route packets
default initial TTL value is 1. Valid settings of first_ttl range from 1 to 255 and must be less than 
max_ttl.

-l <length> length specifies the size of trace route packet.
default packet size is 40 bytes. Valid length settings range from 100 to 1992.
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-p <port> port specifies the port for the destination probe. Valid port settings range from 1 to 65535.
-q <nqueries> nqueries specifies the number of queries execute with each TTL value

default value is 3. All integers greater than 0 are acceptable nqueries values.
-t <tos> tos specifies Type of Server (tos) bit settings in the IP header of trace route packets. 

default value is 0. Valid tos settings range from 0 to 255.
-w <waittime> waittime specifies the period (seconds) a switch waits for a reply to a traceroute packet

default value is 5 (seconds). Valid waittime settings range from 2 to 86400.
-z <pause> pause specifies the period (milliseconds) between successive probes sent by the command. 

default value is 0 (milliseconds). Valid pause settings range from 0 to 3600000.

Entering traceroute without listing any parameters returns the list of available parameters.

Example: The following command traces the route between the originating switch to the endpoint located at IP 
address 10.10.0.1:

traceroute “10.10.0.1”

Example: The following command sends probes to test where ShoreSIP packets may be dropped:
traceroute “10.10.0.1”, “-C”

Figure 45 displays output that results from executing a traceroute command from a switch shell.

Executing Traceroute from ipbxctl.exe
The following is the trace route command line and a complete set of available parameters when performing the operation from 
ipbxctl.exe:

traceroute "target IP address [-CeIS] [-m <max_ttl>] [-f <first_ttl>] [-l <length>] [-p <port>] 
[-q <nqueries>] [-t <tos>] [-w <waittime>] [-z <pausemsecs>]" source ip address

WHERE:
source IP address this parameter specifies the IP address of the switch from which trace route is executed. This 

parameter is mandatory.
All other parameter definitions are identical to the parameters for Traceroute execution from a switch.

Figure 46 displays output that results from executing a traceroute command from ipbxctl.exe.

Figure 45 Invoking Traceroute from a Switch Shell
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Figure 46 Invoking Traceroute from ipbxctl.exe



ShoreWare Server Software Release Notes Enhanced CHM Scripting API for Web Client

24 July 2008 Page 57

Enhanced CHM Scripting API for Web Client

Synopsis
This feature adds the following ShoreWare functions to the ScriptHlp object:

• Find Me: Activate or deactivate FindMe1

• Escalation Notifications: Enable or disable Escalation Notification and specify the active Escalation Notification
Profile.2

Background
The ShoreTel Developer Support program provides the following three Software Development Kits (SDKs) for integrating call 
control and monitoring applications with the ShoreTel phone system:

• TAPI SDK

• COM SDK

• ScriptHlp SDK

The last of these three SDKs, the ScriptHlp SDK, is aimed at server scripts and applications for sending clients to their home 
phone, changing a client's Call Handling Mode, and changing the user group to which an extension is assigned. For this latest 
release, the capacity of the ScriptHlp object has been expanded to include several new functions.

Description
To support the specified ShoreWare features, the following methods have been added to the ScriptHlp.idl interface: 
setAutoFindMe (id(6)), setEscalationProfile (id(7)), sendResyncEvent (id(8)), setSyncMode (id(9)), and sleep (id(10)). 

The following code lists all ScriptHlp.idi methods:

interface ICScriptHlp : IDispatch

{

[id(1), helpstring("method initialize")]
HRESULT initialize();

[id(2), helpstring("method setUserCallHandlingMode")]
HRESULT setUserCallHandlingMode(

[in] BSTR strDN,
[in] BSTR strCallHandlingModeName
);

[id(3), helpstring("method setUserUserGroup")]
HRESULT setUserUserGroup(

[in] BSTR strDN,
[in] BSTR strUserGroupName
);

[id(4), helpstring("method sendUserHome")]
HRESULT sendUserHome(

[in] BSTR strDN
);

1. The new feature does not include the capacity to set the FindMe destination.
2. This feature does not include the capacity to modify Escalation Profiles or steps.
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[id(6), helpstring("method setAutoFindMe")]
HRESULT setAutoFindMe(

[in] BSTR strDN,
[in] VARIANT_BOOL bEnable
);

[id(7), helpstring("method setEscalationProfile")]
HRESULT setEscalationProfile(

[in] BSTR strDN,
[in] BSTR strCallHandlingModeName,
[in] BSTR strEscalationProfileName
);

[id(8), helpstring("method sendResyncEvent")]
HRESULT sendResyncEvent();

// setSyncMode. The default sync mode is "delayed" mode.
// In delayed mode, a system wide resync trigger is sent when the
// ICScriptHlp object is destroyed or sendResyncEvent is called.
// In immediate mode, events are sent when changes are made.

[id(9), helpstring("method setSyncMode")]
HRESULT setSyncMode(

[in] VARIANT_BOOL bImmediate
;

[id(10), helpstring("method sleep")]
HRESULT sleep(

[in] long lMilliseconds
);

ScriptHlp usage can affect system performance because of the high number of database changes that can be made through a 
script. Applications do not see the changes until the script is finished, after which a RESYNC trigger is sent to the applications. 
Applications interpret the RESYNC trigger as an indication to reload ALL configuration information from the database.

For more information, refer to The ShoreTel ScriptHlp Object and ScriptHlp Test Sample ShoreTel ScriptHlp SDK, Release 
3.0.
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Analog Trunks

Synopsis
ShoreWare 7.5 delivers Analog Trunk support for EMEA countries.

Background
ShoreWare was originally designed to support analog trunks in the U.S. ShoreWare 7.5 expands trunk support outside of the US 
to EMEA.

Around 1998, the EEC mandated the ETSI to unify the European analog trunk standards in a document identified as TBR 21. 
The TBR 21 became the effective analog trunk standard early 2000.

Description
EMEA analog loop start trunk support, based on the TBR 21 standard, is supported on all ShoreWare voice switches developed 
in ShoreWare Version 7 and all subsequent releases. BT type 1 (on hook) caller ID support is based on SIN 227 and SIN 242 
standards in the UK.
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System Requirements

Supported Server Configurations
Hardware Requirements

• The ShoreWare software is shipped on a DVD, so servers must be equipped with a DVD drive to facilitate
installation of the software.

Operating Systems

• Windows Server 2003 Standard or Enterprise (SP1, SP2)

• Windows Server 2003 R2 Standard or Enterprise

Note: All Operating Systems are for 32-bit. There is no support for 64-bit in this release.

Supported Upgrade Paths
Upgrade to ShoreTel 7.5

From:

• ShoreTel 6.1

• ShoreTel 7

Note: When upgrading to a later software release, you must upgrade the software on the following devices: 

• Headquarters server

• Remote server

• All switches

• All clients

Note: After upgrading the software, all systems must be restarted and all IP phones must be rebooted.

Windows 2000 no longer supported
ShoreTel has supported the Windows 2000 operating system for several years. As Microsoft is transitioning the product from 
the Mainstream Support to the Extended Support phase, ShoreTel will no longer be supporting this operating system.
ShoreTel 7.5 will not run on the Windows 2000 OS.

Microsoft Internet Explorer 7
Internet Explorer 7.0 has been fully tested for compatibility with ShoreWare Director, the ShoreWare Softphone, and the 
ShoreWare Web Call Handling Mode Client. ShoreTel supports Internet Explorer starting with ShoreTel 6.1 (GA build 
11.14.5506.0) and beyond for these clients.

ShoreWare Converged Conferencing will support Internet Explorer 7.0 by the 7.1 release of the ShoreTel Converged 
Conferencing solution. This is estimated to be available in the second half of 2007.
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Windows Vista Business Edition Operating System
ShoreTel supports the 32-bit version of Microsoft Vista Business Edition, beginning with ShoreTel 7. The following ShoreTel 
clients will be fully supported on Vista Business Edition with ShoreTel 7.5:

• ShoreTel Personal Call Manager

• ShoreWare Softphone

The release date for the use of the ShoreWare Contact Center Agent Toolbar, ShoreWare Agent Manager, ShoreWare Historical 
Reports, and the ShoreWare Contact Center Director on Windows Vista Business Edition has not been determined at this time 
and will be announced separately.

As Vista Business Edition is a desktop operating system, support for the ShoreWare Server on the Vista operating system is not 
planned at this time.

WARNING: If ShoreTel 7.5 PCM has already been installed on a client machine, the system administrator must run a TAPI 
repair executable on that client machine if/when the operating system on that machine is upgraded from Microsoft Windows 
XP to Microsoft Windows Vista Business Edition.

Note that the TAPI repair file does not need to be run under the following conditions:

• If you are doing a fresh install of ShoreTel 7.5 PCM on Windows Vista Business Edition.

• If you are doing a fresh install of ShoreTel 7.5 PCM on Windows XP.

• If you are upgrading to ShoreTel 7.5 PCM from a prior release on Windows XP.

Where is the file located?
The TAPI repair executable file is located in the following directory:
Program Files\Shoreline Communications\Shoreware Server\VistaTapiRepair.exe

Why does this need to be done?
ShoreTel 7.5 PCM will not work under the conditions described above. Executing the TAPI repair file gives permissions to the 
system administrator to create a "NETWORK SERVICE" account (to enable communication between the client and server) and 
gives Access and Launch Permissions.

What is the process for executing the file?
VistaTapiRepair.exe must be run as an Administrator for it to assign the permissions. If the executable is run as an end user, 
the problem will persist. This process should be performed on every client machine that has ShoreTel 7.5 PCM installed and 
that is being upgraded from Windows XP to Windows Vista Business Edition. The client machine must be rebooted after the 
TAPI repair file has been executed.

If multiple clients are being upgraded as part of a "silent install,"  then the system administrator must push the executable with 
administrative privileges through Active Directory. (Please refer to the "Desktop Installation" chapter in the Planning and 
Installation Guide for more information on Microsoft Active Directory or for more information on performing silent client 
installs.)
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Microsoft Outlook 2007 and PCM Integration
ShoreTel 7.5 now supports Microsoft® Outlook 2007. However, the Collaboration Data Objects (CDO) library shipped with 
prior releases (e.g. MS Outlook 2002 and 2003) is not included in Outlook 2007. (This CDO library allowed users to access 
Outlook objects, in addition to allowing users to access the contents of mailboxes and public folders.) As CDO is a prerequisite 
for the ShoreWare and Outlook integration and is required for use of the ShoreTel Calendar Form in Call Manager, the CDO 
library must be installed separately.

Note that MS Outlook 2007 must be installed prior to installing the CDO library. Installation instructions and the 
downloadable CDO file can be found at the following URL:

http://www.microsoft.com/downloads/details.aspx?familyid=2714320D-C997-4DE1-986F-24F081725D36&displaylang=en 

Please check with Microsoft for any updates to the contents at this URL.

Supplemental Documentation
For additional information, refer to http://www.ShoreTel.com 


